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Thesis & Graduation Instructions
for M..S. Students (Thesis Option)

This instruction packet has 3 important components:

TIMELINE FOR FINAL ORAL EXAM / THESIS DEFENSE page 2

PROCEDURES AFTER THE FINAL ORAL EXAM (including instructions on electronic
submission of your thesis and documentation that must be submitted to the Graduate Studies

Use the checklist below to ensure that you have completed all steps required to graduate (do
these tasks in order):

1) Prior to February 10 (for May graduation), June 10" (for August graduation) or October 10" (for
December graduation): Complete the degree application on MyRecords.

2) Complete the Convocation & Accomplishments Survey. The information that you provide is
presented in the Convocation program and ceremony.

3) Complete the Graduate Program Effectiveness & Student Satisfaction Survey.

4) Ensure that your final oral examination committee has electronically reported the results in Seguidor,
within 7 days after completion of the examination.

5) Electronically submit your final thesis to the Digital Commons@UNMC

6) Obtain Verification by the Program Director and Supervisor certifying completion of program
requirements (see additional details below).

7) After completing the above requirements, complete the online Checklist Before Graduation™®*.

**In order to complete the Checklist Before Graduation, you will first need to complete the above steps. The
Office of Graduate Studies will only accept the fully completed checklist and will not accept the requirements
one at a time.

The student is solely responsible for ensuring that all of the tasks listed above are completed, including
submission of the appropriate documents prior to the deadline established by the Graduate Studies Office.
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https://myrecords.nebraska.edu/psp/myrecords/NBM/HRMS/?cmd=login&languageCd=ENG&
https://forms.office.com.mcas.ms/r/2USCJNEqZN?McasTsid=27548&McasCtx=4
https://forms.office.com.mcas.ms/r/C3GwjYGGH2?McasTsid=27548&McasCtx=4
https://seguidor.unmc.edu/
https://forms.office.com/r/EHk1K0YdjS
https://forms.office.com/r/EHk1K0YdjS
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GRADUATE STUDIES

Thesis-Option M.S. Students:
TIMELINE FOR FINAL ORAL EXAM / THESIS DEFENSE

e Prior to February 10" (for May graduation), June 10t (for August graduation) or October 10" (for December
graduation): Complete the degree application on MyRecords.

e Recommended: Two-to-three months in advance of the approximate date of the Final Oral Exam, the student should
consult with his/her Advisor and Advisory Committee and establish the tentative (unofficial) date and time for the
exam. It is also advisable at this point to reserve the rooms in which the public and closed-door components of the
exam will be held. Note that the Final Oral Exam must occur at least 1 week after completing the Comprehensive
Exam and at least 2 weeks before commencement (graduation).

o Atleast 4 weeks before the tentative date of the Final Oral Exam (at least 6 weeks before commencement), the
thesis must be presented to the Advisor, who must determine if it is of sufficient merit (based on scientific criteria)
and in a fit condition (based on formatting and writing quality) to warrant holding the Final Oral Exam. The student
is responsible for ensuring that the thesis is properly formatted (see MASTER’S THESIS REQUIREMENTS) and
has been thoroughly checked for errors in terminology, grammar and spelling prior to presenting the document to the
Advisor. The Advisor may provide feedback to aid the student in revising the document, if necessary. However,
because the student is not eligible for the Final Oral Exam until the thesis is completed and approved by the Advisor,
any revisions to the thesis required by the Advisor must be completed at least 2 weeks before the Final Oral Exam.

o At least 2 weeks before the Final Oral Exam (at least 4 weeks before commencement):

o The Advisor-approved thesis must be presented to members of the Advisory Committee.

o With approval from the Advisor, the student must (via Seguidor™) establish the Examining Committee and
officially schedule the Final Oral Exam. The Advisory Committee must agree to the date & time before this
information is entered into Seguidor. The exam location must also be established at this time. Advance planning
is necessary, because Seguidor will not allow exam scheduling within 2 weeks of the desired exam date. The
exam may be scheduled more than 2 weeks in advance, but only if the Advisor has been given least 2 weeks to
make a judgment regarding the condition of the thesis (see above).

* All members of the student’s Advisory Committee should serve on the Examining Committee.
+ At least 1 NU Graduate Faculty member of the Advisory Committee must be present for the Final Oral
Exam, otherwise the exam must be rescheduled.

o If the thesis includes any published materials, the student is advised to request at this time permission to include

them in the thesis (see MASTER’S THESIS REQUIREMENTS, page 2).

o At least 2 weeks before commencement: Final Oral Exam. It is recommend that you complete the Report on
Master’s Degree (see final page of the M.S. Thesis and Graduation Instructions) and have it available for your
Advisory Committee to sign immediately following the exam (prior to leaving the exam room).

e No more than 7 days after the Final Oral Exam: Results of the Final Oral Exam must be reported to the Graduate
Studies Office (via Seguidor). It is recommended that the Examining Committee complete this task immediately
following the exam (prior to leaving the exam room).

o Atleast 7 days before commencement: All required graduation documentation must be submitted to the Graduate
Studies Office, and the thesis must be submitted electronically to the McGoogan Library for publication via the
Digital Commons@UNMC (see PROCEDURES AFTER THE FINAL ORAL EXAM).
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MASTER’S THESIS REQUIREMENTS

A - GENERAL REQUIREMENTS

The master’s thesis is a written document required by universities for the completion of the Master of Science
(M.S.) or Master of Arts (M.A.) degree. The purpose of the thesis at UNMC is to provide written documentation of
the research achievements of the student, thereby supporting awarding of the M.S. degree by the University of
Nebraska.

The thesis should be a complete and independent document that can be understood without reference to other
materials. It should present original research on a defined problem — research for which the student has taken major
responsibility. Therefore, the research should be primarily the student’s work, although others may have contributed
in a minor way. The thesis should reveal a capacity to carry on independent study or research and should
demonstrate the student’s ability to use the techniques employed in the field of investigation.

B - FORMAT
e Margin Settings: Left =1.5"; Right=1"; Top=1";, Bottom = 1"

o Figures and tables must fit within the same margins as the text. If oversized figures or tables are
included, they should have exactly the same margins as the text, or should be folded as needed to be
contained within those margins.

e Fonts:

o The same font must be used in all elements of the document — including all text, page numbers,
headings, subheadings, tables, figure legends, etc.

o The main text font size must be a minimum of 10 pt; however, 11 pt is recommended.

o Recommended fonts for the main text: 11 pt Arial, 11 pt Helvetica, 11 pt Calibri, 11 pt Minion Pro
Med, 11 pt Palatino Linotype, or 11 pt Times New Roman.

o Headings and subheadings may be in a larger font size, and may be in bold print, but the font must be
the same as the one used in the remainder of the document. Consistency is necessary. If a large type is
used for one subheading, the same size must be used in all subheadings of the same level. If the major
headings and subheadings have two different font sizes, the larger font must be used in the major
headings.

e Line spacing: The document must be double spaced (except figure legends, long headings/subheadings, and
footnotes).

e Paragraph settings: Paragraphs should be preceded by a spacing of 6 pt, and should begin with a Tab of 0.25"
or 0.5" (do not indent the first line of a paragraph using the space bar). Paragraphs should be either left-aligned
or justified (text aligned along both the left and right margins). Be sure to use the same paragraph settings for
the entire body of the document. These paragraph setting constraints do not apply to headings and subheadings,
which generally should be preceded by a spacing of 12 pt (or more) and may be either centered between the
margins (major headings) or left-aligned (subheadings).

e Hyphenation should be employed to avoid unsightly gaps between words when using justified paragraphs
(optional for left-aligned paragraphs). Words of less than 6 letters should not be divided by a hyphen at the end
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MASTER’S THESIS REQUIREMENTS — page 2

of a line. Divided words should not occur at the end of more than two consecutive lines or on the final line at the
bottom of a page.

e Material contained in published manuscripts must be reformatted to thesis specifications. Reprints of published
material are not permitted in the thesis. If you include material (text, figures, etc.) from previously published
work, you must obtain permission from the publisher and you will need to upload proof of the publisher’s
permission when submitting the thesis to the Digital Commons@UNMC (see page 6).

Note: Journals are routinely asked for permission to include published materials in student theses. The process
for obtaining such permission is usually included in the journal’s Instructions for Authors.

e Footnotes should be single spaced and should be placed at the bottom of the page to which they pertain unless
special instructions are provided by the department/program.

e Page numbers must appear in the header at the top right of each page (except the Title Page and Abstract). The
page number may be 9 or 10 pt font, with the Header Position set at 0.5" from the Top and aligned with the right
margin. Be sure to use the same font as the main text. Pages before the Introduction should be numbered with
small Roman numerals (i, ii, iii, iv, etc.). Beginning with the Introduction, number all pages through the
remainder of the document using Arabic numbers (1, 2, 3, etc.). Steps for accomplishing this page numbering
layout in Microsoft Word 2010:

o To insert small Roman numeral page numbers for the initial portion of the document: With the cursor on the 2"
page of the document (not the title page), click on the Insert tab > Page Number = Top of Page = Choose the
option showing the number positioned at right margin. In the Options section of the Design / Header & Footer
Tools Tab, be sure that Different First Page is selected. Click on Page Number - Format Page Numbers > select

i, ii, iii,... in the Number Format pulldown menu. In the same Format Page Numbers window, ensure that the
Page numbering Starts ati. Click on OK.

o To utilize Arabic page numbers beginning with the Introduction: Position the cursor at the bottom of the page
immediately preceding the Introduction. Click on the Page Layout Tab = Breaks = Section Breaks: Next Page.
Then, click on the Insert Tab > Page Number = Top of Page > Choose the option showing the number
positioned at right margin. In the Options section of the Design / Header & Footer Tools Tab, unselect Different
First Page and unselect Link to Previous. Click on Page Number - Format Page Numbers > select 1, 2, 3,... in
the Number Format pulldown menu. In the same Format Page Numbers window, ensure that the Page numbering
starts at 1. Click on OK.

o Unless you are very skilled with the section break and page numbering functions in your word processor, use a
white shape (rectangle or circle; with no border) to obscure page numbers on the Title Page and Abstract pages.

e Figures and tables are generally presented one per page, although multipanel figures are allowed. Each figure
should be numbered consecutively and have a legend that begins with the title/caption (“Figure 1: Giant spiral
galaxy” in the example below) and includes all of the information needed to interpret the figure. The legend may
appear on the page preceding the figure, or on the same page as the figure, being sure to use the same approach
throughout the document. Each figure (with its accompanying legend) should appear in the document in close
proximity to, but not before, the first referral to the figure in the text. The figures and legends should not be
clustered at the end of the Thesis. The student should consult with his/her Advisor to determine the preferred
format.

Useful tip: For ease of editing the document and correct positioning the figures,
do not insert figures and legends into the document until you have a complete draft
of the entire thesis.

Some departments/programs may prefer that figures be integrated within the

main body of text, similar to the appearance of journals or magazines (see
example shown here). Useful tips for implementing this specific approach are

provided below:

o Both the figure and its accompanying legend should be inserted within a single | Figure 1: Giant spiral galaxy. This
text box delineated by a thin black or grey line. (Do not simply draw a rectangle ?;i‘ii;;ie&‘g;hgj dHaI;t;bllflai‘z;fy
around the ﬁgurg and its legend! Copy/pagte the figure into'a'l text b(.))? and type | Camera shows galaxy M101, which is

the legend within the same text box.) This will vastly facilitate editing of the | estimated to contain at least 1 trillion

stars (previously published in ref. 89).
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MASTER’S THESIS REQUIREMENTS — page 3

document and the positioning of the figure and its legend on the page — you will only need to position the text
box, because both the figure and the legend are contained within the textbox.

o When using this approach, the figure legend may be 1- or 2-pt smaller font size than that used for the main body
of text.

o For most relatively small figures (such as the example shown here), format the text box (right click > More
Layout Options) as follows: Text Wrapping = Wrapping Style = Square; Position > Horizontal alignment =
Right relative to Margin. Do not select the Move Object with Text option, otherwise your text box will tend to
“jump around” (move from page to page, or even disappear) as you edit the document!

o If the table or figure spans most of the width of the page within the confines of the margins, format the text box
(right click > More Layout Options) as follows: Text Wrapping = Wrapping Style = Top and bottom; Position
-> Horizontal alignment = Center relative to Margin. Do not select the Move Object with Text option.

0 Once you have inserted the figures, display and editing of the document is most efficient if you activate “show
picture placeholders” (Microsoft Word 2010: Select Customize Quick Access Toolbar — More Commands —
Advanced — under Show document content, select Show picture placeholders. To view the figures as they will
appear in the document, unselect this option.)

Similar criteria (and useful tips) apply to positioning of tables in the thesis document. For example, tables must
be numbered consecutively (Table 1, Table 2, etc.), include legends with titles/captions, and may appear on a
dedicated page or in boxes within the body of text. Regardless of the figure/table presentation mode chosen by
the student, the legend for any previously published figure or table must include the appropriate literature
citation.

® Literature Citations. The student is strongly advised to utilize citation/bibliography software (e.g. EndNote,
Reference Manager, or RefWorks) for incorporating literature citations into the thesis and for generating the
Bibliography. The style of in-text citations should be chosen based on consultation with the Advisor.

C - ORGANIZATION & CONTENT

The thesis may contain some, or all, of the elements listed below. Those elements that are contained in the
document must appear in the order listed and must be formatted as described. Each element should begin on a new
page. Required items are indicated by the checkmark ().

M Title Page: Must be formatted and worded according to the sample attached (with some variation allowed for
use of larger font size for the title and the student’s name). Do not number this page.

Acknowledgments: You may acknowledge those who assisted you during your graduate studies.

M Abstract: The abstract is limited to 250 words including the title and must be typed in a format according to the
sample attached. Do not number the pages of the abstract. Utilize the word count feature of a word-processing
program to ensure that the abstract conforms to the 250-word limit.

M Table of Contents: The Table of Contents (sample attached) should provide the reader with an analytical view
of the materials covered by the study, together with the order of appearance in the document. All headings and
subheadings listed in the Table of Contents must agree word-for-word with the headings/subheadings appearing in
the body of the document.

Useful Tip: The student is advised to spend a few minutes up front learning how to have their word-processing program
(e.g. Microsoft Word) automatically generate a Table of Contents — this will save hours in the long run.

List of Figures: If any illustrative or graphic materials are used, a List of Figures must be provided. The figure
titles/captions included in the list must agree word-for-word with the titles/captions appearing in the body of the
work. Page numbers must be those on which the legend appears.

Useful Tip: The List of Figures can be generated automatically in Microsoft Word (which refers to this as inserting a
Table of Figures) based on captions (figure titles) that you have inserted into the document.
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MASTER’S THESIS REQUIREMENTS - page 4

List of Tables: If any tables are included in the thesis, a List of Tables must be provided. Page numbers must be
those on which the table appears. The List of Tables is can be generated automatically in Microsoft Word though
the same process used for generating a List of Figures.

List of Abbreviations: Define each abbreviation used in the document, according to the sample attached.

Chapters: The body of the thesis is composed of Chapters that provide a complete presentation of the project
in a systematic and organized manner. The Chapters should be numbered (1, 2, 3, etc.), with each Chapter bearing
a title. Students should consult with their Advisors for guidance in organizing the Chapters and their content. While
there is considerable flexibility in this regard (which may vary with the field of study), most master’s theses at an
academic medical center will contain the following Chapters:

e Chapter 1: Introduction. This Chapter should present a comprehensive and integrated presentation and critical
analysis of the literature relating to the overall thesis topic. It should also frame the questions addressed by the
thesis.

e Chapter 2: Methods. This Chapter should include a description of the procedures utilized in the research in
sufficient detail to indicate that the student has a thorough understanding of the techniques used to answer the
question and to permit others to replicate the work.

e Chapter 3: Results. This Chapter should be a complete presentation of the research findings in a logical and
clear fashion.

e Chapter 4: Discussion. This Chapter should address the results in terms of their importance, their limitations,
their place in our current knowledge, the conclusions drawn based on the results, and the future directions or
implications suggested by the results.

M Bibliography: This section must provide complete listing of all literature cited in the thesis. Each citation
should list all authors (within reason; limit to 20 for reports of large clinical trials, for example), full title of the
paper, journal name (standard abbreviations used by PubMed are acceptable), volume, range of pages (not simply
the 1% page), and the publication year. The list may be arranged by order of citation or alphabetically by author, at
the discretion of the student and his/her Advisor.

Useful Tip: Do not waste time creating your own bibliography citation format within your reference citation software;
rather, select one of the options provided by the software. There will be hundreds among which to choose.

Appendices: May include surveys, ancillary observations, detailed protocols developed for specific procedures,
recipes for key reagents, etc. If there is more than one appendix, number them A-to-Z, and include a title for each
appendix (e.g., APPENDIX A: PATIENT CONSENT FORM).
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MASTER’S THESIS REQUIREMENTS - page 5

UNMC MASTER’S DEGREE PROGRAM NAMES (for use on title page)

Official names of UNMC Master’s programs, as approved by the Board of Regents:

e Biochemistry & Molecular Biology Graduate Program

e Biomedical Informatics Graduate Program

e Cancer Research Graduate Program

e Emergency Preparedness Graduate Program

e Immunology, Pathology & Infectious Disease Graduate Program
e Medical Anatomy Graduate Program

e Medical Sciences Interdepartmental Area Graduate Program

e Molecular Genetics & Cell Biology Graduate Program

e Pathology & Microbiology Graduate Program

e Pharmaceutical Sciences Graduate Program

Specializations (MSIA Only):

Biological Defense & Health Security e Health Practice & Medical Education Research
¢ Clinically Relevant Basic Research * Munroe-Meyer Institute

o ) e Oral Biology
e C(Clinical & Translational Research ) )
e Patient-Oriented Research

e C(Clinical & Translational Research Mentored o Physical Therapy

Scholars Program

Revised & Updated May 2025



Sample TITLE PAGE

«—1.5"—

by

Wei Lu

A THESIS

MSIA graduates only: Graduate Program
Specialization (see page 5) j‘> (Specialization)

should be indicated, enclosed
within parentheses.

_______________ Do not number |__

SEROTYPIC AND GENOTYPIC DIVERSITY
OF GROUP A BOVINE ROTAVIRUSES

the title page!

—1"—>

Margins

(shown for illustrative
purposes only)

Presented to the Faculty of
the University of Nebraska Graduate College
in Partial Fulfillment of the Requirements

for the Degree of Master of Science

Genetics, Cell Biology & Anatomy ¢ graduate program (see

University of Nebraska Medical Center

Official name of your

page 5), single-spaced.

Do not include
professorial rank
(Associate or Assistant)

Under the Supervision of Professor Gerald E. Duhamel ¢ or degree.

If you have co-advisors, use
Professors rather than listing
the title separately for each.

Omaha, Nebraska E
Either the month and year of i
the final oral examination, : i
or the month and year of April, 2015 i
graduation. i
Advisory Committee: i
Laura D. Brown, M.S. Neil Armstrong, M.S. i
John P. Jones, M.D. Robert W. Johnson, M.S. i
T e o B B B B B e B B e e o )
T
1"



Sample ABSTRACT |

Do not number the

EVALUATION OF NUTRITIONAL METHODOLOGY AND EXPERI Pages of the abstract

DESIGN IN THE STUDY OF RIBOFLAVIN DEFICIENCY:

«—1.5"— —1"—

ASSESSMENT OF PHYSICAL AND BIOCHEMICAL LESIONS

Larry H. Gerthoff, M.S. <i: The abbreviation “M.S.” must follow

your name on the abstract only.

iAdvisor: Myron A. Mehlman, M.S.
This must be the year

i University of Nebraska, 2013
:'T of your graduation.

he adequacy of some components of conventior! the study of riboflavin

r 7

ideﬁciency was questioned. This thesis attempted to evaluate how several important changes in
the experimental design affected the response of the albino rat to riboflavin deficiency. This was

accomplished by analysis of a large variety of criteria including classical physical lesions and



T vii

Sample TABLE OF CONTENTS ]i" Page on which each heading
T TABLE OF CONTENTS ] I
s ;ACKNOWLEDGEMENTS .......................................................................................................... i/f e
EABSTRACT .................................................................................................................................... 1ii§
ETABLE OF CONTENTS ...ttt ettt st b e et e bbb e bt eatetesaeeaeebe s Viii
;LIST OF FIGURES ...ttt ettt ettt sttt esbe e st etesseensesseeneensesseeneens ixi
ELIST OF ABBREVIATIONS ... .ttt ettt st ettt nae Xiii
ECHAPTER 1: INTRODUCGCTION ...ttt ettt st e eaeees IE
E Renal Anatomy & PhySIOIOZY ....c.ccouiiiiiiiiiiiiiiieieeseeste ettt v e v sre e s tae e eeve e 1;
E DHADELES MEILILUS. ....ceutitieiieiieieieie ettt ettt sttt s eatenae s 1 IE
E EStrOZen RECEPIOTS .....uviiiiiiiiiii ettt ettt e e et e e et e e s s bte e e e s abaeeeeenneeeeennes 175
E HYPOTRESIS ...ttt et ettt e te e st e saaesabesabeeabeensaesseesnseensesnseenseensaens 23;
;CHAPTER 2. METHODS ...ttt ettt ettt et et st e aeseeeneenens 255
E ATIINALS ...ttt ettt sttt ettt bbb ettt be et nees 255
E IMOUSE COLOMIES ....eneieniiiieiieieitieie sttt ettt ettt et ettt et st be st e e bt et et sbeetenaes 25;
E Induction of TYPe 1 DIabEtes......ccveviiiiiiiieiicrieeecee ettt sr e re v e b e reesrae s 265
E Separation of Membrane and CytoSolic FTactions ..........ccccceevierierienienieeieeeesee e 275
E Western Blotting & ImmunoflUOTESCENCE. ........ecviiviiiriieriieiie e et eee e re b reesree s 28;
E Glomerular Filtration Rate ..........cocuiiiiiiiiiieiii ettt 3 IE
E Urine and Plasima ASSAYS ......cccueeriieriieriieriieiie et et et et et steete et esteesteesatesaseenseeseesseesneesnees 335
E StatiStICAL ANALYSES.....ccuviiiiiieeriiertiestesre et e ereesteesteesteestbeesseesseesteessaessseassessseesseesseesssenssessseenns 35;
;CHAPTER B RESULTS .ttt ettt ettt et e sseesseseessensanseesaensenns 365
E Tissue Distribution of EStrogen RECEPLOrS........cccvveviiiriiiriieiieiie ettt eve e e 365
E Estrogen Receptor Protein levels in Various TiSsues...........ccovieiiiiiiiiiiiiinnenn.... 41;
E Estrogen Receptor Localization in the Kidney................cooiiiiiiiiiiiiin, 455
E {}Subcellular Localization of Estrogen Receptors in the Kidney.............................. 495
Use different indentations to indicate i
various subheading levels [~ TTTTTTTTTTTTTTT T mmmmmmm e T- """"""""""""""""
17



Sample LIST OF ABBREVIATIONS

—1.5"—

4-AP
Angll
[Ca*"];
CMH
DCFH-DA
DETC
DFX
DHE
DM
DMTU
DNase
Ex
ESRD
FCS
GFR
GIRK
GLUT4
HbA .
H>0O»
HEPES
HOCI
JGA
Karp channel

BKca channel

LIST OF ABBREVIATIONS

4-aminopyridine

angiotensin II

intracellular free calcium ion concentration
1-hydroxy-3-methoxycarbonyl-2,2,5,5-tetramethylpyrrolidine
2", 7'-dichlorodihydrofluorescein diacetate

sodium diethyldithiocarbamate trihydrate
deferoxamine

dihydroethidium

diabetes mellitus

dimethylthiourea

deoxyribonuclease

potassium equilibrium potential

end-stage renal disease

fetal calf serum

glomerular filtration rate

G protein-regulated inward rectifier potassium channel
glucose transporter (type 4)

glycated hemoglobin

hydrogen peroxide
4-(2-hydroxyethyl)-1-piperazineethanesulfonic acid
hypochlorous acid

juxtaglomerular apparatus

ATP-sensitive potassium channel

large conductance Ca?*-activated potassium channel

xii
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Additional Details of the Requirements Listed on Page 1

Convocation & Accomplishments Survey,
https://forms.office.com.mcas.ms/r/2USCINEqZN?McasTsid=27548&McasCtx=4 . You will find it useful to
have your CV handy when completing this survey.

The information collected via this survey provides Graduate Studies with data that are needed for program
evaluation, accreditation and other reports. It will also facilitate the celebration of your accomplishments at
the Graduate Studies Convocation Ceremony, as well as allowing us to contact you in the future.

Graduate Program Effectiveness and Student Satisfaction Survey,
https://forms.office.com.mcas.ms/r/C3GwjYGGH2?McasTsid=27548&McasCtx=4.
The information collected via this survey will help Graduate Studies improve the education experience for

future students. Please be thoughtful and truthful in completing this survey and be reassured that the results
are completely anonymous.

Verification from the Program Director and Supervisor that you have completed the program requirements.

To do so, you will need a copy of an email chain (print to pdf) with both the Program Director and Supervisor
responding “I agree” to the following statement: “I verify that [student name] has completed all requirements in
the [program name] for graduation under supervision of /mentor name]”. Alternatively, you can use the physical
form to gather signatures (template provided on the last page of these instructions).

ELECTRONIC SUBMISSION THE THESIS

After making any revisions requested by your Advisory Committee, the final thesis must be submitted
electronically (as a PDF file) to the McGoogan Library of Medicine for deposition into the UNMC electronic repository
(Digital Commons@UNMC). There will be no opportunity for editorial or other changes in the thesis after submission
to the library. Once submitted, it will be reviewed by library staff before publishing. Before submitting, please read all
relevant policies and/or submission guidelines.

The submission process consists of the following steps:
1. Read and accept the Submission Agreement (provided online at the beginning of the process)
2. Provide information about yourself and any co-authors
3. Upload your electronic file and associated files

Before you begin, please be sure you have the following items:
o The exact title of your thesis
e The abstract (for ease of submission, you will want to copy/paste the abstract from a Microsoft Word
document into the online abstract submission box)
o A list of keywords
e A PDF file of your work
o Electronic copies of copyright permissions (to be uploaded as Additional Files)

Embargoes & Restrictions

What is an embargo? An embargo is a delayed release of information. Consult with your Advisor about whether or

not you require an embargo and the appropriate length of the embargo (6 months, 1 year, or 2 years). By default, a 6-
month embargo will be applied. You will have an opportunity to establish a different embargo duration when uploading
your thesis. Your thesis will not be available to download from the Digital Commons@UNMC until the embargo has
expired. The embargo begins the date of submission, not the date of online publication. If you choose not to embargo
your work, it will be immediately available to the public.

Revised & Updated May 2025
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Why would you want to embargo your thesis? Some reasons to request an embargo include:

e There may be patentable rights or sensitive data in the work.

o There is an ethical need to prevent disclosure of sensitive information about persons, institutions, etc.
e You may plan to submit portions of the work for publication in a journal.

e  Your Advisor may plan to use some of the results as preliminary data for a grant.

Submission Instructions

1.

Once you have completed your manuscript and are ready to electronically submit it to Digital Commons@UNMC,

go to http://digitalcommons.unmc.edu/etd/ and click on the Submit Your Work link, located on the lower right
hand menu bar.

You will be asked to login or create an account. Most graduates will need to Create new account. In order for you
to receive monthly usage reports, please use your permanent email address.

Before proceeding, you must check your email to confirm your account.

Once confirmed, you will be directed to the Submission Agreement. Please read the agreement and accept the
terms.

You will now see a form in which you must enter all of the required information — title, keywords, Advisor(s),
abstract, etc. Note that the Date of Award should be the date on which your degree will be conferred
(commencement/graduation day).

At the end of the form, you must upload your manuscript (Upload Full Text) as a PDF file.

Upload Additional Files associated with your thesis, including documentation that you have permission to use any
copyrighted materials and materials that have already been published (i.e. in a journal article). This is also the point
at which you can upload audio, video, animations, simulations, etc.

After reviewing the submission, the library will notify the Graduate Studies Office that the submission process has
been completed.

The document will be available for download from Digital Commons@UNMC at the end of the embargo period (if
any).

BOUND COPIES OF THE THESIS

Neither the Graduate Studies Office nor the McGoogan Library of Medicine requires hard copy or bound copies of

the thesis; however, the library will arrange for binding of as many copies as requested with payment of the binding fee
($20.00 per copy). All copies intended for binding should be printed single-sided on high quality photocopy paper.
Each student should consult with his’her Advisor regarding the number of bound copies of the thesis that should be

prepared. Some common practices are listed below:

e Some graduate programs require that one bound copy of the thesis be filed in the departmental office that
administers the program.

e  Ordinarily, one bound copy is presented to the PI/Advisor who directed the study.

e In some graduate programs, it is customary for the student to present each member of his/her Advisory
Committee with a bound copy.

e Students should also consider providing a bound copy for their parents (they will be very proud!), as well
as keeping one copy for themselves.
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Verification that the Student Meets Program Requirements

Use this form if you wish to gather physical signatures. Alternatively, we also accept a pdf (click print to pdf) of an
email chain with both the Program Director and Supervisor responding “I agree” to the following statement: “I verify
that [student name] has completed all requirements in the [program name] for graduation under supervision of /mentor
name]”.

Date:

Student Name:

Graduate Program Name and Acronym:

The above-named student has been reported as follows concerning the degree requirements. All requirements
established by the listed Graduate Program have been satisfied.

Supervisor Name and Signature:

Name

Signature

Graduate Program Director Name and Signature:

Name

Signature
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